
Understanding Dialer and Serial Connections

Use Dialer to establish a connection to a network over a modem or serial line.    To establish the connection, you 
must dial into a host on the network that is designed to accept serial connections:    you must have an account 
on the host.    Once dialed into the host, you start PPP (Point-to-Point Protocol) or SLIP (Serial Line Internet 
Protocol) on the host and on your workstation.    Once PPP or SLIP communications are established, your 
workstation is a node on the network, and you can use the network as if you had a direct network connection.

Serial connections are mainly useful for connecting to a network from a remote site, for example, for 
telecommuting or for business trips.

Getting Access to the Host

In order to use Dialer to make a serial connection to a network, you must get an account on the host that allows 
serial connections to the network.    Ask your network administrator for an account.    Collect this information:
n Your user name for the account, if required.
n Your password, if required.
n The command required to start PPP or SLIP on the host (if you have a choice, choose PPP).
n The telephone numbers for the host.    If you are only given one number, ask if there are any backup numbers.
n Whether anyone has already written a working Dialer script for automating the login to the host, or if there are

existing Dialer profiles for making the connection.
n Whether the host dynamically assigns you an IP address, or whether you must already have an IP address.    If 

you must have an IP address, ask your network administrator for the address and the subnet mask (we 
recommend you use the default subnet mask 255.255.255.255).

Configuring Your Workstation for Serial Connections

Once you have an account set up on the host, you must configure your workstation to make the connection:
1 Configure a serial interface for your workstation using the Cisco TCP/IP Suite Configuration utility.    If you are 

using dynamically-assigned IP addresses, you only need to select Serial for Interface Type, and check Enable 
Interface, when adding the serial interface.    If you are going to use your workstation as a router between a 
LAN and serial network connection, enable IP Forwarding on the Configuration Utility's Global tab.    You must 
reboot to complete the configuration.

2 If you are initially going to make a manual connection to the host, choose Manual Connect>Configure from the
Interface menu in Dialer and configure your workstation and modem settings according to the configuration of 
your workstation.    Select the correct connection type (PPP or SLIP), modem speed (if the speed of your 
modem is not available in the list, select the next fastest speed), port, IP address (if you do not use dynamic IP
addresses), and DNS server addresses.    You can leave the other settings at their defaults initially, unless your 
network administrator tells you to change them, or if you know they are not correct for your workstation.

3 If you are going to create a profile to help automate connections to the host, click the Connect button and then
click the New button.    Then, configure your workstation and modem settings.

Once you have configured your workstation, you can dial the host and establish the serial connection.    Unless 
your network administrator can provide you with a functioning Dialer profile, first try making a manual 
connection to the host.    Once you succeed in making a manual connection, you can use a printout of your 
interaction with the host to create a script to automate the login process.

Serial connections over modems can be unreliable.    If you fail to make a connection on the first try, try making 
the connection again a few times.    If you still cannot make the connection, contact your network administrator 
for help.

Why choose PPP over SLIP?

If you have a choice between using PPP and using SLIP, you should choose PPP.    PPP is a newer and more 
reliable protocol that allows you to run more than one networking protocol (for example, you can use Microsoft 
networking (NetBIOS), not just TCP/IP).    PPP also includes error correction, support for synchronous and 
asynchronous communications, and support for more user-authentication protocols.



Understanding Dialer Profiles

You can connect to a host using Dialer either by manually dialing and logging into the host, or by using a profile 
to automate the dialing and logging-in process.    Setting up Dialer profiles for systems you frequently use makes 
it easier for you to establish the connection.

Before creating a profile for a host, manually connect to the host.    Before you click the PPP or SLIP button to 
finish the connection, print out the contents of the terminal window.    This makes it easier to create a login script,
which is part of every Dialer profile.

When you have made successful manual connections to the host, create the profile by clicking the Connect 
button and then clicking the New button.    Give the profile a name you find meaningful, and then fill in the tabs 
using the information you used to make the manual connection.    Right-click the fields on the tabs for 
information about each setting.

After creating the profile, test it to make sure the information is correct.    It might take a few tries to create a 
correct login script.

When you have a working profile, you can then quickly connect to the host by clicking the Quick Connect button 
and choosing the host's profile from the list of available profiles.    You can also create an icon on your desktop 
that starts Dialer using a specific profile.

{button ,AL(`Profiles;Scripts')}    More information about Dialer profiles and login scripts



Understanding the Dialer Connection Table and Connection Statuses

The main Dialer window includes a connection table to show your serial connections.    The table includes these 
columns:

T
The transmit light.    Blinking indicates that you are sending packets over the serial interface.

R
The receive light.    Blinking indicates that you are receiving packets over the serial interface.

Profile
The profile used to make the connection.    "Manual" indicates a manual connection.

Status
The state of the connection:
Active

There is communications traffic on the connection.
Answer

A remote response was detected from the modem.
Connecting

A connection to the remote host is in progress.
Dialing

The modem is dialing the host.
Error

An error occurred in the modem, communications port, or kernel interface.
Idle

An active connection currently has no traffic.
Linked

A serial line session has been established with a remote host.
Negotiating

The kernel is negotiating the connection characteristics.
Offhook

The modem could not connect to the telephone line.
Shutdown

The communications and connections are shutting down.
Startup

The communications and connection parameters are initializing.
Unknown

The current status cannot be determined.
Waiting

The modem was sent information but has not yet responded.
Modem

The name of the modem, as selected in the profile.    For manual connections, this is shown as the 
communications port you are using (for example, COM1).



Understanding Dial on Demand

Normally when using a serial connection, if you want to use an application that requires a network connection, 
you must first start Dialer and establish the connection before trying to use the other application.    However, if 
you enable Dial on Demand in Dialer, instead of first establishing the network connection, you can just start 
using the other application, and that application starts Dialer to establish the network connection itself.

For example, if you enable Dial on Demand, and you need to make a Telnet connection, you can just start Telnet 
and attempt the connection.    Telnet starts Dialer, Dialer establishes a serial connection to the remote network, 
and then Telnet completes its connection to the host to which you attempted to connect.

Any WinSock-compliant application can use Dial on Demand.

{button ,KL(`Dial on Demand,')}    Related Topics



For More Information about Dialer

Recommended Reading

For an excellent conceptual overview of TCP/IP networking concepts, we recommend the following books:
Comer, Douglas E., Internetworking with TCP/IP, Volumes I and II, Prentice Hall
Black, Uyless D., TCP/IP and Related Protocols, McGraw-Hill

{button ,JI(`glossary.hlp',`Recommended_Books_on_TCP_IP_Connectivity')}    List of recommended books.

Relevant RFCs

For more information on serial TCP/IP connections, consult the following RFCs:

SLIP RFC 1055
PPP RFC 1661
PPP PAP and CHAP Authentication RFC 1334

{button ,JI(`glossary.hlp',`How_to_Get_Internet_RFCs')}    How to get RFCs.



Click the Connect button, or choose Connect from the Interface 
menu, to connect to a remote host using a Dialer profile.

Click the Disconnect button, or choose Disconnect on the 
Interface menu, to disconnect the connection selected in the 
connection table.

Click the Manual Connect button, or choose Manual 
Connect>Connect from the Interface menu, to connect to a 
remote host by entering the modem commands yourself.    Use 
Manual Connect to record the interaction between Dialer and the
remote host, so that you can use the information to create a 
Dialer profile.

Click the Quick Connect button to quickly connect to a remote 
host using a profile you already created.    Click the profile you 
want to use on the Quick Connect list.

Click the Exit button, or choose Exit from the File menu, to close 
Dialer.    All active sessions are stopped.

Choose Manual Connect>Configure to configure modem and other settings for making manual connections.    
Configure these settings before attempting to make a manual connection.



Choose Disconnect All to disconnect all serial connections created during this Dialer session.



Choose Program to set various Dialer program options, including options to allow other applications to 
automatically use Dialer to create a serial connection when required.



Check Toolbar to display the Dialer shortcut buttons below the menu.



Check Bubble Help to display short help text when you move the cursor over the toolbar buttons.



Check Status Bar to display the status bar at the bottom of the screen, which displays a short description of a 
menu option or button that is selected, and the current date and time.



Connect Dialog Box

Use the Connect dialog box to connect to a remote host using a profile, or to add, modify, or delete profiles.    
Right-click the fields in the dialog box for context-sensitive help.

{button ,AL(`Profiles')}    Things you can do with profiles



Click the Connect button to connect to the remote host specified in the selected profile.



Displays the names of existing Dialer profiles.



Displays any notes you added to the profile for your information.



Click the Close button to close the dialog.



Click the Help button to access online help.



Click the New button to create a new profile.



Click the Modify button to change the settings in the selected profile.



Click the Copy button to create a copy of the selected profile.    You can use this copy as a basis for another 
profile.



Click the Delete button to delete the selected profile.



Click the Cancel button to close the dialog without saving changes, or to abort the connection.



Click the Message Log button to display the connection protocol exchange with the remote host.



Message Log Dialog Box

Use the message log to view the exchange between Dialer, the modem, and the remote host.    If you want to 
save the exchange, check Log to File and choose a name for the log file, which is saved to disk.    Each time you 
make a connection, this log is overwritten.    Right-click the fields in the dialog box for context-sensitive help.

{button ,AL(`Message Log')}    Things you can do with the Message Log



Displays the protocol exchange with the remote host during the connection.



Check Log to File to have the message log written to a file on disk.    You are prompted to choose a log file.    This 
file is overwritten each time you make a serial connection.



New Profile Dialog Box

Use the New Profile dialog box to name your new Dialer profile.

{button ,AL(`Profiles')}    Things you can do with profiles



Enter the name for the new profile.



Click the OK button to close the dialog box and save your changes.



Remote Host Tab

Use the Remote Host tab to select the serial connection type (PPP or SLIP), the telephone number that should be 
dialed, your passwords for the remote host, and other information required to connect to the remote host.    
Right-click the fields in the dialog box for context-sensitive help.

{button ,AL(`Profiles')}    Things you can do with profiles



Choose the type of serial connection:    PPP (Point-to-Point Protocol) or SLIP (Serial-Line Internet Protocol).    Ask 
your network administrator which protocol you should use.



Enter the telephone number of the remote host.    Include all digits you need to dial, including long-distance 
codes and PBX dial-out numbers (for example, 9).    Use a comma to indicate Dialer should briefly pause between
dialing numbers.    For example, if you need to dial 9 before dialing the telephone number 555-1212, enter 
9,555-1212.



Enter your user name, if any, for the remote host.



Enter one or two login passwords. An asterisk appears for each character you enter for the password.    Use 
additional passwords when accessing routers or other systems that handle incoming phone access to a computer
system.    For example, if the router requires a password, enter that password in the Password 1 field, and the 
password for the remote host in the Password 2 field.



Check Prompt for Passwords if you want Dialer to prompt you to enter your passwords on the remote host while 
connecting to the host.    If you do not have Dialer prompt for passwords, you must enter the required passwords 
in the Password fields.
If you do not have Dialer prompt for passwords, anyone that has access to your workstation can connect to the 
remote host using this profile without knowing the passwords.    Consider your security requirements when 
deciding whether to have Dialer prompt for passwords.



Enter any other information that needs to be sent to the remote host, other than your passwords and user 
names.    Ask your network administrator if there is other information you can, or must, send when connecting to 
the host, and the format for that information.



The PPP Authentication group determines the type of authentication Dialer requests when connecting to the 
remote host using PPP.    Ask your network administrator which type of authentication the remote host requires.
If no PPP authentication is used, leave these fields empty.

If PAP (Password Authentication Protocol) is used, enter your authentication password but not your user name.    
This password is not the same as the passwords you enter the Password fields for the remote host.

If CHAP (Challenge-Handshake Authentication Protocol) is used, enter both your authentication password and 
user name.    (CHAP provides more network security than PAP.)



Local Host Tab

Use the Local Host tab to specify information about your workstation.    Right-click the fields in the dialog box for 
context-sensitive help.

{button ,AL(`Profiles')}    Things you can do with profiles



Enter the IP address of your workstation, unless the address is dynamically assigned; for example, 
192.168.34.22.
If you are using PPP and do not have an IP address, leave this field blank.

If you are using SLIP, your network administrator can supply the IP address for your workstation.    If your login 
script indicates that you expect an IP address from the remote host, the address is inserted into this field during 
script processing.    If you are making a manual connection, you will see the IP address in the terminal window 
when interacting with the host if the IP address is assigned when you log in.



Enter your workstation's subnet mask, for example, 255.255.255.255.    Ask your network administrator for the 
correct subnet mask for your system.    The subnet mask indicates which hosts are on your local network and 
which hosts must be reached through a router.    We recommend you use the default subnet mask 
255.255.255.255.



Enter your workstation's host name, if there is one.



Enter your workstation's domain name.



Check Use as Default Route to use your IP address and subnet mask as the default route.    The default route 
determines the network path used for sending data to other hosts or networks when there is no specific route for
the destination in your workstation's routing table.    Ask your network administrator what you should define for 
routing information for your network.



The Routing table lists the routes defined for your workstation.    Ask your network administrator what you should
define for routing information for your network.    The display columns are:
n Destination:    the IP address of a remote host or network
n Gateway:    the IP address of the gateway used to reach a destination address
n Qualifier:    whether the destination is another host or network



Click the Add button to add routes to the routing table.



Click the Delete button to delete the selected route from the routing table.



The DNS server table lists the IP addresses of the DNS servers you are using.    DNS servers allow you to address 
hosts by host name instead of by IP address.



Click the Add button to add DNS servers to the profile.



Click the Delete button to delete the selected DNS server.



Add Route Dialog Box

The Add Route dialog box lets you add a route to the routing table.    Right-click the fields in the dialog box for 
context-sensitive help.

Ask your network administrator what you should define for routing information for your network.    To add the 
route, enter the IP address of the gateway and destination machines, and indicate whether the destination 
address is the address of a network or another host.



Enter the IP address of the gateway you want to use to reach your destination.    The gateway must be on the 
same subnet as your workstation.



Enter the destination address, which is the IP address of the remote host or network you want to reach.



Click Host if the destination for this route is a host; Network if it is a network.



Add DNS Dialog Box

The Add DNS dialog box lets you add DNS (Domain Name System) servers, which allow you to address other 
hosts using host names rather than IP addresses.    Enter the IP address of your DNS server.



Enter the IP address (in dotted-decimal format) of the DNS Server.



Modem Tab

Use the Modem tab to specify modem settings and commands.    Right-click the fields in the dialog box for 
context-sensitive help.

{button ,AL(`Profiles')}    Things you can do with profiles



The Settings group determines your modem type, its line speed, the port name, and other modem usage 
options.



Choose your modem's manufacturer from this list.    See the documentation for your system if you are not sure 
who made the modem.    If your manufacturer is not on the list, select (Standard Modem Types).    If your serial 
connection is a cable connecting your machine to the host, select Generic Modem Drivers.



Choose the model of your modem from this list.    If your model is not on the list, choose a compatible model.    
See your manufacturer's documentation for more information.



Choose the baud rate of your modem.    If the correct baud rate is not listed, select the next highest speed.



Choose the port to which the modem is connected to your workstation.



Enter the number of times Dialer should attempt to connect to the remote host before reporting a failure.



Enter how long Dialer should wait (in seconds) for a response from the remote host before aborting the 
connection attempt.



Check Follow DCD if your modem supports the DCD (Data Carrier Detect) pin on the RS-232 interface.    See your 
manufacturer's documentation for more information.



Check Hardware Flow if your modem supports the ability to enable or disable the Clear To Send (CTS) and the 
Ready To Send (RTS) pins of the RS-232 interface.    See your manufacturer's documentation for more 
information.



Check 7 Bits Until Connect to have the modem send data as 7-bit characters until the connection with the 
remote host occurs.    Some online service providers require that communications be handled in this way: check 
with your network administrator or service provider.



The Commands group determines which commands are used with your modem, and the responses expected 
from the modem.    These commands and responses are primed with values determined by your modem settings;
do not change them unless you find they are incorrect.    See your manufacturer's documentation for more 
information about the commands expected by your modem.



Enter the command for initializing the modem.    See your manufacturer's documentation for more information 
about the command expected by your modem.



Enter the command for resetting the modem.    See your manufacturer's documentation for more information 
about the command expected by your modem.



Enter the command used to dial the telephone number.    See your manufacturer's documentation for more 
information about the command expected by your modem.



Enter the characters that should immediately follow the Dial command:    for example, ^m, which indicates a 
carriage return (pressing the Enter key), is typical.



Enter the command used to disconnect the telephone line (drop carrier).    See your manufacturer's 
documentation for more information about the command expected by your modem.



Enter the string of characters that Dialer should receive from the modem to signal a command acknowledge:    
typically OK.    See your manufacturer's documentation for more information about the reply sent by your 
modem.



Enter the string of characters that Dialer should receive from the modem to signal a carrier detect response:    
typically CONNECT.    See your manufacturer's documentation for more information about the reply sent by your 
modem.



Enter the string of characters that Dialer should receive from the modem to signal a phone busy response:    
typically BUSY.    See your manufacturer's documentation for more information about the reply sent by your 
modem.



Click the Defaults button to return the modem commands and replies back to the Dialer's default settings for the
modem make and model.



Understanding Dialer Scripts

Use the Script tab in the Profile settings dialog to create a script for Dialer to use to log into the remote host.    
This script automates the logging-in process, and contains the responses you expect to receive from the host 
during login, and the replies you intend to give.    For example, a host usually asks you for your password when 
you connect to it:    use Dialer scripts to tell Dialer what to expect for the password prompt, so Dialer knows when
to send your password to the host.

Your script needs to send all the data required to successfully log into the host and start PPP or SLIP on that host. 
Unless your network administrator can tell you exactly what you should enter for the script, you should first 
make a manual connection to the host and print the exchange between Dialer and the host.    Use this as the 
basis for creating your script.

Before making a manual connection, ask your network administrator for the commands needed to log into the 
host and to start PPP or SLIP.
{button ,JI(`MNDIAL32.HLP',`Writing_Dialer_Scripts')}    Writing Dialer scripts
{button ,JI(`MNDIAL32.HLP',`Understanding_Dialer_s_Built_in_Variables')}    Understanding Dialer's built-in 

variables
{button ,JI(`MNDIAL32.HLP',`Tips_for_Writing_Dialer_Scripts')}    Tips for writing Dialer scripts



Writing Dialer Scripts

A Dialer script is a series of commands or data sent to the remote host and the replies you expect from the host. 
The commands, data, and replies can be:
n Text, which Dialer sends or expects exactly as you enter it.
n A preset variable, which Dialer sends to the host using data you supply in the profile, or which Dialer receives 

from the host and uses to supplement the data you supply in the profile.

You can mix text and variables in the same string, or you can separate the text and variable in different lines.

Each sequence in the script is assigned a timeout value, which is the number of seconds Dialer waits for a reply 
before deciding the connection cannot be completed.    Only change the timeout value if your script consistently 
times out before the connection is made, and you know that there is nothing wrong with your script.

If you check Auto Dial on the Script tab, Dialer dials the remote host before it executes your script.    Thus, when 
using auto dial, the first line in your script should only contain data you expect to receive from the remote host.   
If you do not check Auto Dial, then your script must contain the modem commands needed to dial the host.

Before writing your script, examine the printout you made of a successful manual connection.    Highlight the 
data you received from the host, and the data you had to supply to the host.    Your printout might look similar to 
this:

atdt5551212
CONNECT 28800/ECLC

Line 2

User Access Verification

Password:
RemoteHost>ppp default
Entering PPP mode.
Async interface address is unnumbered (Ethernet0)
Your IP address is 192.168.34.22.  MTU is 1500 bytes.

Header compression will match your system.

~~y}#A!}!}! }4}"}&}
The bold text is text you enter to complete the connection.    You would also enter your password after the 
Password prompt, but the password is not displayed when you type it.    Let's analyze this interaction, and the 
script that would result.

First, when you made the manual connection, you entered the command to dial the modem:    atdt5551212 
(where 555-1212 is the telephone number of the host).    If you use auto dial (by checking Auto Dial on the Script 
tab), do not enter this command in the script:    Dialer issues this command for you.    Let's assume you are using 
auto dial, which is easiest.    (You can represent that you want to send nothing in the first line of your script by 
selecting <NOTHING> from the drop-down list in the Send field at the bottom of the dialog.)

Once the connection is made, Dialer receives the text beginning with "CONNECT" and ending with "Password:".    
Thus, the first line in your dialer script must represent this data.    However, you do not have to tell Dialer all the 
text that you expect to receive from the remote host.    Because characters can be lost during the initial 
connection between Dialer and the host, you should include only a small portion of the last characters that you 
expect to receive.    In this example, the last characters you expect is "Password:".    It is at this point that the 
host expects a response from you.    Therefore, the first entry in your script should be Password:, or, better yet, 
just word:, or a similarly short, but unique, string.

To add this to your script, type word: into the Expect combo box in the lower part of the Script tab and click the 
Add button.    This line is added to the script display that is the upper part of the Script tab.    If you make a 
mistake in entering lines in the script, you can change any line by selecting it and clicking the Modify button.    
You can also delete a line by selecting the line and clicking the Delete button.

The first line in the script now tells Dialer to expect the remote host to send the text word:.    Once Dialer sees 
this character string, it moves to the next line in the script.    If you look again at the printout of the manual 
connection, you see that when the remote host sends the text Password:, it waits for you to send the password.   
Thus, for the second line in your script, you must tell Dialer to send your password.

To tell Dialer to send your password, select $PASSWORD1 from the drop-down menu in the Send combo box at 
the bottom of the Script tab.    If you had to press the Enter or Return key after you entered your password during
the manual connect, check Append Carriage Return to Send String, which tells Dialer to press Enter after sending



the password.    $PASSWORD1 is a variable that contains whatever you entered in the Password 1 field on the 
Remote Host tab for the profile.    Dialer has several built-in variables that let you send data stored in various 
fields in the profile, without having to type the information into the script.    This makes it easier for you to update
information like your password, so that you do not have to modify your script once you get it working.

Before you click the Add button to add this to your script, look again at the manual connect printout to see what 
Dialer should expect after sending the password.    In this printout, the only text Dialer should expect in return is 
RemoteHost>.    Thus, enter Host> in the Expect field, and click the Add button.    The second line in your script 
should now indicate that Dialer sends your password, and expects to receive a prompt with the text Host>.

When you get the RemoteHost> prompt, you entered ppp default, the command (on this host) for starting PPP.  
To tell Dialer to send this command, type ppp default in the Send field.    Do not click the Add button yet.

After you entered this command during the manual connect, the host started PPP and sent you several messages
before it started sending binary data (represented by the ~~y{#A characters, which might be different on the 
host you are trying to connect to).    Once you started getting binary data, you clicked the PPP button to establish
the manual connection.    When Dialer gets to the last line in your script, it takes over and does the equivalent of 
clicking the PPP (or SLIP) button.    Although it is not required, you might want to enter the initial character of the 
binary data in the Expect field to indicate the end of the interaction between the script and the host.

Click the Add button to add this last line to the script.    The script should now look like this:

Send Expect Timeout
<NOTHING> word: 30
$PASSWORD1<cr> Host> 30
ppp default<cr> ~ 30

If you are using SLIP, your script is slightly more complicated.    With SLIP, you must send the host an IP address 
when starting SLIP, or receive the IP address from the host.    See the sample SLIP script for an example.

{button ,AL(`Scripts')}    Related Topics



Sample SLIP Script 

Writing Dialer Scripts describes the process of writing a Dialer script, and shows an example of a PPP script.    If 
you are using SLIP connections, your script is slightly more complicated than the PPP script.    The information in 
this topic assumes you have already read the topic on writing Dialer scripts.

For this example, assume that this is the printout from your manual SLIP connection:

atdt5551212
CONNECT 28800/ECLC

Line 2

User Access Verification

Password:
RemoteHost>slip default
Entering SLIP mode.
Async interface address is unnumbered (Ethernet0)
Your IP address is 192.168.34.22.  MTU is 1500 bytes.

Header compression will match your system.
These are some of the differences between the examples of making a manual PPP connection and making a 
manual SLIP connection:
n If you are receiving an IP address from the host, PPP handles it automatically.    SLIP does not.    In order to 

complete the SLIP connection, you have to enter the IP address sent to you from the host in the IP address edit
box on the Manual Connect dialog.    Only then do you click the SLIP button to establish the connection.    (This 
difference is not represented in the printout above, but in the actions required to complete the SLIP manual 
connection.)

n The host pauses after the header compression message, waiting for you to click the SLIP button, whereas for 
PPP, the host immediately begins sending binary data.    You can ignore this pause when writing the script.

The process of writing the SLIP script is the same as for writing the PPP script.    However, because SLIP does not 
automatically handle the IP address, you must account for receiving the IP address from the host, or for sending 
it to the host.    Use the $IPADDRESS variable to set or send the IP address.

If you are receiving the IP address from the host, as in this example, you must set the $IPADDRESS variable 
based on the text sent from the host.    This host sends your IP address in the sentence "Your IP address is 
192.168.34.22."    To set the $IPADDRESS variable, first indicate the text string you expect ("IP address is"), then 
indicate that you want to set the $IPADDRESS variable with whatever text comes next.    The complete script for 
this connection is:

Send Expect Timeout
<NOTHING> word: 30
$PASSWORD1<cr> Host> 30
slip default<cr> IP address is $IPADDRESS 30

If you are not receiving your IP address from the host, but instead have a pre-assigned IP address (for example, 
192.168.34.22), the command for starting SLIP might be slip 192.168.34.22 instead of slip default.    In this 
case, you must send $IPADDRESS to the host, rather than set it using a response from the host.    The complete 
script for the connection would be:

Send Expect Timeout
<NOTHING> word: 30
$PASSWORD1<cr> Host> 30
slip $IPADDRESS<cr> <NOTHING> 30
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Understanding Dialer's Built-In Variables

Dialer includes built-in variables that let you easily send information to the host that is defined in other parts of 
the Dialer profile.    This simplifies your profile, so that you can change the corresponding information without 
editing a working Dialer script.    You can also use the $IPADDRESS variable to dynamically store an IP address 
that the host sends you in the corresponding field in your profile.

These are the built-in variables:

$IPADDRESS
The address specified in the IP Address field in the Local Host tab.    If used as an Expect variable, $IPADDRESS
sets the IP address based on text received from the host.    Any IP address received from the host is not kept 
permanently, because the address might change the next time you connect to the host.

$PASSWORD1
The password specified in the Password 1 field in the Remote Host tab.

$PASSWORD2
The password specified in the Password 2 field in the Remote Host tab.

$PHONE
The phone number specified in the Phone Number field in the Remote Host tab.    Use this with a modem 
command when you do not use auto dial.    For example, to dial the host, send atdt $PHONE.

$USERDATA1
The string specified in the User Data 1 field in the Remote Host tab.    For example, you could enter the 
command for starting PPP or SLIP in the User Data 1 field, then send $USERDATA1 instead of the command in 
the script.

$USERDATA2
The string specified in the User Data 2 field in the Remote Host tab.

$USERNAME
The name specified in the User Name field in the Remote Host tab.

<NOTHING>
Indicates that you want to send nothing, or expect to receive nothing, at this particular part of the script.    
This is a keyword, not a variable.    You can leave the Send or Expect field blank instead of using the 
<NOTHING> keyword.

<cr>
A carriage return.    This is equivalent to pressing the Enter key.
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Tips for Writing Dialer Scripts

Dialer scripts are used to automate what is normally a human-computer interaction, so they require some effort 
to test and troubleshoot before they work correctly.    Ask your network administrator if there is a copy of a 
working script for dialing into the host, so that you can just type in the script.    If you have to create the script 
yourself, here are some tips to help you quickly write a working script:
n When writing a script for a new host, always make a successful manual connection first, and print out the 

interaction between you and the host.    To print the interaction, you must click the Print button before you click
the PPP or SLIP buttons.    Highlight the places in the interaction where you had to send data to the host.

n When choosing the data you expect to receive from the remote host, pick only the last few characters before 
the host pauses for a response from you.    Sometimes, the first part of the data gets lost in the transmission.    
For example, the prompt for the host might be RemoteHost>, but in any given connection attempt, Dialer 
might only get the string emoteHost>.    If you tell Dialer to look for RemoteHost>, Dialer will not consider 
emoteHost> to be a match.    Dialer continues to wait until the script times out, meaning that your 
connection fails.    If the prompt is RemoteHost>, use Host> as your Expect value.

n The text string you enter in the expect field must be unique in comparison to the other text you receive 
between your previous send string and your next send string.    For example, if you receive two lines that 
contain the word "is" ("Asnyc interface is unnumbered," then "Your IP address is ..."), if you use only the string 
'"is" in the Expect field, Dialer matches the string to the first occurrence of "is."    If you key on the word "is" to 
set $IPADDRESS, $IPADDRESS gets set with the wrong value.

n To test your script, try connecting to the host using the profile.    When Dialer displays the Connect startup 
message dialog, click the Message Log button to watch the interaction between Dialer and the host.    If there 
is a problem with any of your Expect values, Dialer should pause at the corresponding places in the 
interaction.    Correct the entries in your script where Dialer does not recognize your Expect values.

n If you see ERROR or RROR in the message log, the preceding command sent to the modem caused an error.    
Change that command on the Modem tab to a correct command for your modem.

n Initiating a serial connection can be unreliable.    Dialer might be unable to complete the connection even if 
your script is correct.    Retry failed connections to ensure that the failure was not due to problems in the 
communications network.

n If Dialer is sending your data correctly, but times out before receiving the reply from the host, try increasing 
the timeout value for the script entry that the host does not reply to.
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Displays the Dialer script, which is used to automate the process of logging into the remote host.    Click the Help 
button for information on how to create a script.    The display columns are:
n Send:    Commands, data, or variables that you send to the remote host.
n Expect:    Data you expect to receive from the remote host.
n Timeout:    The number of seconds Dialer waits after executing the entry before Dialer decides the connection

cannot be completed.



Check Auto Dial if you want Dialer to initialize the modem and dial the remote host's telephone number (entered 
on the Remote Host tab) before executing the script.    If you do not use auto dial, you must include modem 
initialization and dialing commands in the script.



Click the Modify button to change the selected line in the Dialer script.



Click the Delete button to delete the selected line in the Dialer script.



Enter the data or variable that Dialer should send to the remote host.    Click the Help button for detailed 
information on how to create a Dialer script.



Enter the data or variable you expect to receive from the remote host.    Click the Help button for detailed 
information on how to create a Dialer script.



Enter the number of seconds Dialer should wait for the expected reply from the remote host before quitting the 
login attempt.



Click Append Carriage Return to Send String if you normally have to press the Enter or Return key on the remote 
host to enter commands.    The carriage return acts like the Enter or Return key.



Click the Add button to add the data in the Send, Expect, and Timeout fields as an entry in the Dialer script.    The
entry is placed after the line selected in the Script display.



Modify Script Entry Dialog Box

Use the Modify Script Entry dialog box to change an existing entry in the Dialer script.
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Options Tab

Use the Options tab to set various Dialer options.    Right-click the fields in the dialog box for context-sensitive 
help.
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The Connections group controls how Dialer manages your connection with the host once it is made.



Check Re-establish Connection Upon Loss if you want Dialer to automatically redial the host if the connection to 
the host is unexpectedly broken.    If you do not check this, Dialer gives you the option to reconnect if the 
connection is broken.



Check Minimize on Connect if you want the Dialer application to be minimized to the desktop once the 
connection is made.



Check Prompt on Disconnect if you want to be asked for a confirmation when you try to disconnect from the 
remote host.



Enter the number of minutes Dialer should wait when there is no activity with the remote host before 
automatically closing the connection with the host.    Enter 0 to indicate that Dialer should never automatically 
close the connection.



The Header Compression group determines whether header compression is used with TCP packets for SLIP 
connections.    This group does not apply to PPP connections.    TCP Header compression can speed 
communication between your workstation and the host.    To use header compression, both your workstation and 
the remote host must enable it.
If you click On, Dialer sends compressed headers.    If the host does not support compressed headers, you cannot
use applications that use TCP packets; for example, Telnet and FTP do not work.    Applications that use IP, UDP, 
or ICMP packets do work; for example, Ping works.

If you click Off, compressed headers are never used.

If you click Negotiated, Dialer waits as long as possible for the host to send a TCP packet, to see if the host uses 
header compression.    If Dialer receives a compressed header, Dialer uses header compression.    If Dialer 
receives uncompressed headers, or if Dialer decides it has waited long enough and cannot continue waiting for 
the host to send a TCP packet, Dialer uses uncompressed headers.



Enter any descriptive information that you want to associate with the profile.    This information is displayed in 
the Connect dialog box when you select the profile.



Copy Profile Dialog Box

Use the Copy Profile dialog box to create a new profile based on an existing profile.    Enter the name you want to
give to the new profile and click OK.



Displays the name of the profile you selected to use as a base for the new profile.



Enter the name of the new profile you want to create.



Passwords Dialog Box

Use the Passwords dialog box to enter the passwords needed to log into the remote host.    You can avoid seeing 
this dialog if you enter your passwords on the Remote Host tab in the Dialer profile and you uncheck Prompt for 
Passwords.    However, including your passwords in the Dialer profile allows anyone with access to your machine 
to connect to the remote host using that profile.



Configure Manual Interface Settings Tab

Use the Configure Manual Interface Settings tab to configure the modem settings and protocol used for manual 
connections.
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The modem group controls your modem settings.



Configure Manual Interface Host Information Tab

Use the Configure Manual Interface Host Information tab to configure your workstation's TCP/IP settings used for 
manual connections.
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Manual Connect Dialog Box

Use the Manual Connect dialog box to connect to a remote host by manually entering the commands required to 
dial the modem, log onto the host, and start PPP or SLIP on the host.

To connect to the host, first dial the modem (see your modem documentation for the correct command).    The 
typical command for dialing the modem is atdt.    For example, to dial 555-1212, enter atdt 555-1212.

Use all the numbers required to dial the host, and use the comma to indicate places where Dialer should pause 
in dialing the number.    For example, if you must first dial 9 to get the telephone line required to dial the number,
you typically must pause after dialing the 9 to get the telephone line.    In this case, enter atdt 9,555-1212.

Once connected to the host, log onto the host.    Then, start PPP or SLIP using the commands required on the 
host.    (Contact your network administrator if you do not know the command.)    If you are using a specific IP 
address, rather than receiving one dynamically from the host, you must enter the IP address on the command 
even if you entered the IP address in the Configure Manual Connection dialog.    If you entered the IP address in 
the Configure Manual Connection dialog, that IP address is shown in the IP address edit box for your 
convenience.

To start PPP

Once you enter the command to start PPP, the host starts PPP and sends you a series of messages.    After the 
messages, the host starts sending you binary data, which is represented in the terminal window as a 
meaningless series of characters.    Once you see these characters, click the PPP button to establish PPP on your 
workstation.    With PPP, you never have to enter an IP address in the IP address edit box on this dialog.

To start SLIP

Once you enter the command to start SLIP, the host starts SLIP and sends you a series of messages.    If you are 
dynamically assigned an IP address by the remote host, the host shows you your IP address in one of these 
messages.    Enter that IP address in the IP Address edit box, then click the SLIP button.    You cannot start SLIP 
without entering an IP address in the IP address edit box.
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The Terminal View window is a command-line interface to the modem and, once a connection is made, to the 
remote host.    Enter the modem commands required to dial the remote host (for example, atdt 555-1212, or, if 
you must dial 9 to get an outside line, atdt 9,555-1212):    press the Enter key to send the command to the 
modem.    Once the modem makes the connection to the host, log onto the host and enter the command for 
starting PPP or SLIP.    Click the Help button for more information on making manual connections.



The IP address field shows the IP address entered in the Configure Manual Connection dialog, if you entered an IP
address in that dialog (that is, you use a specific IP address).    When using a specific IP address, you must tell the
remote host your IP address when you start PPP or SLIP on the remote host.    The remote host cannot see the IP 
address in this field:    you must include the IP address on the command you enter in the Terminal View window.
For SLIP connections, you must enter an IP address in this field to complete the SLIP connection.    This field tells 
Dialer which IP address you are using.    If you receive the IP address dynamically from the host, enter the IP 
address in this field when the host sends it to you.    Then you can click the SLIP button.

For PPP connections, this field can always be empty, even if you are using a specific IP address.



Click the PPP button to complete the PPP connection once the remote host starts sending binary data after you 
start PPP on the remote host.
Click the SLIP button to complete the SLIP connection to the remote host.    You must enter your IP address in the 
IP address field before you can complete SLIP connections.



Click the Print button to print the contents of the Terminal View window.    If you want to print this information, 
you must click Print before you click the PPP or SLIP buttons.



Program Options Dialog Box

Use the Program Options dialog box to set general options that affect the way Dialer works.    You can also set up 
Dial On Demand, which allows other applications (such as Telnet and FTP Client) to start dialer when they need 
to establish a serial connection to complete a connection you try to make using those applications.    This means 
that you can connect to a host using Telnet without manually making a serial connection to the network.    Any 
program that requires network access through the WinSock interface can use Dial On Demand to establish a 
serial connection using Dialer.



Dial on Demand allows other applications (such as Telnet and FTP Client) to start dialer when they need to 
establish a serial connection to complete a connection you try to make using those applications.    This means 
that you can connect to a host using Telnet without manually making a serial connection to the network.    Any 
program that requires network access through the WinSock interface can use Dial On Demand to establish a 
serial connection using Dialer.



Check Enabled to start Dial on Demand, which allows any program that uses the WinSock interface to make a 
network connection to use Dialer to establish the network connection if there is no active network.    For example,
Dial on Demand lets you start FTP Client and attempt an FTP connection without first starting Dialer and 
establishing a serial connection to the network.    If a network connection is active, applications use the existing 
connection:    they do not start Dialer to create a second, serial connection.



Check Use Profile if you want Dialer to automatically make a network connection using the profile you select 
when an application starts Dialer using Dial on Demand.    If you do not select a profile, Dial on Demand starts 
Dialer, but you must establish the network connection yourself.



Check Alert on System Suspend if you want Dialer to display a message reminding you that you have an active 
network connection when your workstation tries to enter a power management mode (such as sleep or power 
save).    If you do not check Alert on System Suspend, your workstation goes directly into the power save mode.



Check Prompt on Delete if you want to be prompted when you try to delete a Dialer profile.    This ensures that 
you do not accidentally delete a profile.



Check Save Screen Size and Location if you want Dialer to use its last screen size and location the next time 
Dialer starts.



To start Dialer:
Choose Dialer from the Cisco Suite 100 program group on the Start menu.

Tips:
n You can create an icon which, when double-clicked, will start Dialer and connect to a host using the profile you 

select.
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To disconnect a serial connection:
1 Select the connection in the connection table on the main Dialer window.
2 Click the Disconnect button, or choose Disconnect from the Interface menu.
Tips:
n To disconnect all serial connections, choose Disconnect All from the Interface menu.
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To exit Dialer:
Click the Exit button, or choose Exit from the File menu.

Tips:
n If any connections are active, Dialer prompts you before exiting the program.    All serial connections are 

disconnected when you exit Dialer.
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To set Dialer program options:
1 Choose Program from the Options menu.
2 Check the options you want to use.    Right-click the fields on the dialog for information on each item.

{button ,KL(`Dial on Demand,')}    Using Dial on Demand



To set up Dial on Demand:
1 Choose Program from the Options menu.
2 Check Enabled in the Dial on Demand group.
3 If you always want to use the same profile for Dial on Demand connections, check Use Profile and select the 

profile in the drop-down list.
4 Click OK.    Dial on Demand remains enabled even when you exit Dialer.
Tip:
n When you check or uncheck Enabled for Dial on Demand, the change does not take effect until you reboot 

Windows.
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To make your workstation a router between networks:
1 Start the Cisco TCP/IP Suite Configuration Utility.
2 Click the Global tab.
3 Check Enable IP Forwarding.
4 Save the configuration change and reboot your workstation.
Tips:
n IP forwarding only happens if you are connected to two interfaces (serial and LAN) simultaneously.    For 

example, if you are connected to your company’s network over an Ethernet line, you might also dial into 
another network over a serial line.    Packets that are sent directly to your system through one interface are 
forwarded out the other interface.

n IP forwarding might be a security violation at your company, because it can allow unwanted and insecure 
traffic from one network into another network.    In general, you only want to enable packet forwarding if you 
can trust the traffic on both networks, and if you specifically need your machine to act as a gateway router 
between the networks.    Check with your network administrator before enabling IP forwarding.



To connect to a Microsoft network over a PPP connection:
1 Right-click on Network Neighborhood, and select Properties from the menu.    If the Client for Microsoft 

Networks is not installed, click the Add button and install it.
2 Click the Identification tab on the Network Properties dialog, and fill in your computer and workgroup name.    

(Do not click OK.)
3 Click the Configuration tab on the Network Properties dialog, and double-click Client for Microsoft Networks.    

Check Log on to Windows NT domain, and enter the name of your domain.    Click OK.
4 Double-click the Cisco TCP/IP Stack 100 protocol that is bound to the dialup adapter, and click the Utility 

button.
5 Click the NBT tab in the Configuration Utility.    Check Enable NetBIOS over TCP/IP, and fill in the information 

according to your network setup.    If you are using WINS servers, click the Set button and select one of the 
settings that uses WINS (typically, you should select Use WINS first).    Click Done when you are finished, but 
do not restart Windows.

6 When you return to the Network Properties dialog, select Client for Microsoft Networks as the primary logon, 
click OK, and restart Windows.

Tips:
n Ask your network administrator for your workgroup and computer name, the NT domain name, the IP 

addresses of the WINS servers, and any other settings you should use when enabling NetBIOS over TCP/IP.
n When you connect to the network using PPP, the Microsoft Network asks you to log in once it notices that you 

have connected to the network.    It might take one or two minutes before the network notices your connection.
Once connected, you can see the other machines on the network by double-clicking Network Neighborhood.

n See the online help for Microsoft Windows for more information about using Microsoft networking.
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To configure the serial interface for manual connections:
1 Choose Manual Connect>Configure from the Interface menu.
2 On the Settings tab, choose whether you want to use PPP or SLIP for the interface from the Connection Type 

list.
3 On the Settings tab, choose the speed of your modem from the Speed list.    Select the next highest setting if 

your modem's speed is not on the list.
4 On the Settings tab, choose the COM port to which your modem is connected from the Port list.
5 On the Host Information tab, enter your IP address if your network administrator assigned you an IP address, 

and fill in the other fields according to the information supplied by your network administrator.    Right-click the
fields on the tab for information about each setting.

Tips:
n For most manual connections, you only need to set the connection type, modem speed, and port.
n If you want to use host names, you must add a DNS server on the Host Information tab.    Ask your network 

administrator for the IP addresses of the DNS servers.
n You can set other options for manual connections.    Right-click the fields on the Configure Manual Interface 

tabs for information about each setting.
n You must obtain an account on the remote host before you can connect to it.    Contact your network 

administrator for the information required to make the connection.
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To manually connect to a remote host:
1 Click the Manual Connect button, or choose Manual Connect>Connect from the Interface menu.
2 In the Terminal View window, enter the command for dialing the remote host.    This is usually atdt followed by 

the telephone number.    Include all numbers required for dialing the host.    For example, if you must dial 9 to 
get an outside telephone line, you must include 9 in the telephone number.    Use a comma to indicate that 
Dialer should pause between numbers when dialing.    For example, to dial 555-1212 when you need to dial 9 
first, enter:
atdt 9,555-1212

3 If Dialer successfully connects to the remote host, you see text sent from the remote host.    Log into the host 
using the user name, password, and other information required by the host.    Ask your network administrator 
for this information.

4 Start PPP or SLIP on the host using the command supplied by your network administrator.
5 If you are using PPP, click the PPP button once the remote host starts sending binary data (this looks like a 

random series of characters).
6 If you are using SLIP with dynamically-assigned IP addresses, enter the IP address in the IP Address field and 

click the SLIP button.    If you are using an assigned IP address, the address should already be in the edit box if 
you appropriately configured the interface:    make sure there is an IP address in the field and click the SLIP 
button.

Tips:
n You must configure the manual interface before trying to make a manual connection.
n If you want to print your interaction with the remote host, to simplify the creation of a profile for the host, you 

must click the Print button before clicking the PPP or SLIP buttons.
n The terminal window display does not allow for editing.    If you make a mistake, you cannot backspace over 

the incorrect text and retype it: the modem still sees your original typing.    If you make a mistake, and you 
know the modem will see it as an incorrect command, just press Enter, wait for the modem to respond ERROR,
and then type in the correct command.    However, if you type the wrong telephone number, click Cancel and 
try your manual connection again.

n Any text you paste into the window (using Ctrl+P) is typed directly to the modem.    You can only paste modem
commands into the window: any other text you try to paste into the window is ignored.

n If your typing does not show up in the terminal window, the modem has not been properly reset.    Press Enter 
and type in AT&F or ATZ to reset the modem.    This should allow your subsequent typing to show up in the 
window.
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To print the manual interaction with the remote host:
Once you have completed a manual connection to the point where you intend to click the PPP or SLIP 

button, click the Print button first.    Once you click the PPP or SLIP buttons, you can no longer print the information 
in the Terminal View window.
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To create a Dialer profile:
1 Click the Connect button, or choose Connect from the Interface menu.
2 Click the New button to create a new profile.
3 Enter the name you want to give the new profile and click OK.
4 On the Remote Host tab, select the connection type (PPP or SLIP) and enter the telephone number for the 

remote host.    Include all numbers required to dial the host, and use a comma to indicate where Dialer should 
pause when dialing the number.    Either enter your passwords on this tab, or check Prompt for Passwords if 
you do not want to have your passwords saved in the profile.

5 On the Local Host tab, enter your IP address if your network administrator assigned you one.    Check Use as 
Default Route unless your network administrator tells you to set different routing information.    If you want to 
use host names, be sure to add the IP addresses of the network's DNS servers.

6 On the Modem tab, select the information that describes your modem.    If your modem's speed is not in the 
Speed list, select the next highest speed.

7 On the Script tab, create the appropriate script for logging into the remote host.
8 Set any other options you want to use on the various tabs.    Right-click the fields on the tabs for specific 

information about each option.    When finished, click OK.
Tips:
n You must obtain an account on the remote host before you can connect to it.    Contact your network 

administrator for the information required to make the connection.
n Once you create the profile, test it by trying to connect to the host using the profile.    If the connection does 

not work, modify the profile until all settings are correct.    During the connection, click the Message Log button
to see the interaction between Dialer, the modem, and the remote host.    This helps you determine the 
location of the problem.    For example, if you see ERROR or RROR after a command sent to the modem, you 
know that the command sent to the modem was incorrect.    Go to the Modem tab and change that command 
to the correct command, as documented in your modem's user guide.

n Once the profile works, you can connect to the host by clicking the Quick Connect button and choosing the 
profile from the Quick Connect list.
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To connect to a remote network using a profile:
Click the Quick Connect button and choose the profile you want to use from the displayed list of profiles.

Tips:
n You can also connect using a profile by clicking the Connect button, selecting the profile in the Connect dialog, 

and clicking the Connect button on the Connect dialog.
n As Dialer attempts to make the connection, you can view the message log, which displays the interaction 

between Dialer, the modem, and the remote host, by clicking the Message Log button.    If you view the 
message log, Dialer prompts you to complete the connection to the host once it finishes processing your 
script.    If you want to save the message log, check Log to File and select a log file name.
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To connect directly to a host through a serial port:
1 Create a profile that uses Direct Connection for the modem Manufacturer (on the Profile Modem tab), and 

Serial for the modem Model, according to the type of direct connection you have with the host machine.    
Leave the telephone number blank (on the Remote Host tab), and uncheck Auto Dial on the Script tab.

2 Ensure that the host is running PPP or SLIP, as appropriate, and that it allows direct connections.
3 Connect to the system using the profile, by selecting it in the profile list shown when you click either the Quick

Connect button or the Connect button.
Tips:
n The modem speed (Modem tab) must be the same as the speed that the remote host allows.    Direct 

connections cannot negotiate speed settings.
n Make a manual connection before creating the profile, so that you can create an appropriate script.    The first 

action of the script is likely to be sending a carriage return, (which is represented in the script as 
<NOTHING><cr>).

n As Dialer attempts to make the connection, you can view the message log, which displays the interaction 
between Dialer, the modem, and the remote host, by clicking the Message Log button.    If you view the 
message log, Dialer prompts you to complete the connection to the host once it finishes processing your 
script.    If you want to save the message log, check Log to File and select a log file name.
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To modify a Dialer profile:
1 Click the Connect button,  or choose Connect from the Interface menu.
2 Select the profile you want to modify and click the Modify button.
3 Change the profile settings as desired.    Right-click the fields on the tabs for information about each setting.
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To delete a Dialer profile:
1 Click the Connect button,  or choose Connect from the Interface menu.
2 Select the profile you want to delete.
3 Click the Delete button.
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To set up an icon to quickly dial a host using a profile:
1 Right-click on the Windows desktop and select New>Shortcut.
2 Click the Browse button and select Mndial32.exe in the Cisco TCP/IP installation directory (usually MultiNet).
3 In the Create Shortcut dialog, add a space and the -h parameter after Mndial32.exe, and enter the name of 

the profile you want Dialer to use when you double-click on the icon you create.    For example, if the profile is 
named "Main Office", enter Mndial32.exe -h Main Office.

4 Click the Next button, and enter the name you want to give to the icon (for example, "Dial Office").
Tips:
n You do not have to add the -h parameter when you create the shortcut.    Once the shortcut is on your desktop,

you can add the parameter, or change the profile, by right-clicking the icon and selecting Properties.    Choose 
the Shortcut tab in the Properties dialog, and add the parameter to the command string in the Target field.

n You can add the shortcut to the Start menu rather than the desktop.    To add the shortcut to the Start menu, 
choose Settings>Taskbar from the Start menu, choose the Start Menu Programs tab, and click the Add button.  
Then follow the directions above.

n You can also enter the -h option as /h.
n You can start Dialer from a DOS command prompt using the same command and options used for creating the 

Windows shortcut.
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Troubleshooting: Script Times Out

When connecting to a host using a Dialer profile, the connection might fail due to the script timing out.    This 
means that the remote host did not respond to Dialer with the expected reply in the time allotted for the reply.    
It might also mean that Dialer was not successful in resetting the modem.

To resolve this problem, try again to connect to the host using the profile.    If the connection is successful, the 
problem was probably only a temporary one.    Because serial connections over telephone lines can be unreliable,
you should anticipate that even a correct profile will fail occasionally.

If the problem persists, try again to connect to the host using the profile, but this time click the Message Log 
button on the Connect status dialog and view the interaction between Dialer and the remote host.    Are you 
seeing the text you expect from the remote host?    If not, cancel the connection and make a manual connection 
to the host, to determine if the text displayed by the host has changed since you created your Dialer script.    If it 
has changed, rewrite the Dialer script and try to connect using the repaired profile.

If the text displayed by the host has not changed, try increasing the timeout value for the lines in your script.    If 
an increased timeout value does not help, call your Help Desk and ask for assistance.
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Troubleshooting: RROR or ERROR in Message Log

When connecting to a host using a profile, you can view the message log to see the interaction between Dialer, 
the modem, and the remote host.    Occasionally, some characters get dropped in this interaction, which makes it
difficult to identify certain messages.

If you see RROR in response to a command Dialer sends to the modem (such as a command to initialize, reset, 
or dial the modem), the modem is actually sending Dialer the response ERROR.    This means that the modem 
does not understand the command Dialer used.

To fix this problem, first identify the command the modem tried to process when it encounter the error.    
(Successful commands are usually followed by the response K or OK.)    The modem commands Dialer uses are 
defined in the profile on the modem tab.    Match the problem command to the entry on the Modem tab.    Consult
your modem's documentation, and replace the incorrect command with a correct one.
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